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Preface

This document describes the installation of the Sun Fire™ Visual Grid system
consisting of the networking interconnect of Sun Fire 4800/6800 Visual Grid
computers and Sun Fire V880z Visual Grid computers through Sun XVR-4000
graphics accelerators.

Note – The procedures in this manual should only be performed by experienced
system administrators.

How This Book Is Organized
Chapter 1 provides an overview of the Sun Fire Visual Grid system and an overview
of the installation process.

Chapter 2 describes the Sun Fire Visual Grid system software requirements.

Chapter 3 describes the Sun Fire Visual Grid hardware requirements and supported
system configurations.

Chapter 4 describes installing the Sun Fire Visual Grid interconnect and Sun Fire
Visual Grid software.

Chapter 5 describes the dzadmin configuration tool, which administrators use to
configure a Sun Fire Visual Grid system.

Chapter 6 provides security information through the Sun Fire Visual Grid software
daemon program (dzdaemon).

Appendix A provides troubleshooting information.
xi



Using UNIX Commands
This document might not contain information on basic UNIX® commands and
procedures such as shutting down the system, booting the system, and configuring
devices. See the following for this information:

� Software documentation that you received with your system

� Solaris™ operating environment documentation, which is at:

http://docs.sun.com

Typographic Conventions

Typeface*

* The settings on your browser might differ from these settings.

Meaning Examples

AaBbCc123 The names of commands, files,
and directories; on-screen
computer output

Edit your.login file.
Use ls -a to list all files.
% You have mail.

AaBbCc123 What you type, when contrasted
with on-screen computer output

% su

Password:

AaBbCc123 Book titles, new words or terms,
words to be emphasized.
Replace command-line variables
with real names or values.

Read Chapter 6 in the User’s Guide.
These are called class options.
You must be superuser to do this.
To delete a file, type rm filename.
xii Sun Fire Visual Grid System Installation and User’s Guide • November 2003
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Shell Prompts

Accessing Sun Documentation
You can view, print, or purchase a broad selection of Sun documentation, including
localized versions, at:

http://www.sun.com/documentation

Contacting Sun Technical Support
If you have technical questions about this product that are not answered in this
document, go to:

http://www.sun.com/service/contacting

Shell Prompt

C shell machine-name%

C shell superuser machine-name#

Bourne shell and Korn shell $

Bourne shell and Korn shell superuser #
Preface xiii
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Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and
suggestions. You can submit your comments by going to:

http://www.sun.com/hwdocs/feedback

Please include the title and part number of your document with your feedback:

Sun Fire Visual Grid System Installation and User’s Guide, part number 817-2365-10.
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CHAPTER 1

Sun Fire Visual Grid System
Overview

This chapter provides an overview of the Sun Fire Visual Grid system.

� “Overview” on page 1
� “Installation Kit” on page 2
� “Installation Process Overview” on page 3
� “Technical Support” on page 3

The Sun Fire Visual Grid system consists of the Sun Fire 4800/6800, the Sun Fire
V880z, and the Sun Fire Visual Grid software and networking interconnect.

Overview
The Sun Fire Visual Grid system enables a host (master) computer to use remote
(slave) computers for rendering to displays using Sun XVR-4000 graphics
accelerators. The system runs over a high-speed, networked Sun Fire Visual Grid
interconnect. The Sun Fire Visual Grid software makes this connection transparent to
the master running the application; the application functions as if the Sun XVR-4000
graphics accelerators are located local to the master. Thus, the software enables large
numbers of displays to be addressable from a single computer in this system
without modifying application software, and often with little or no performance
degradation or change in user experience. Local Sun XVR-4000 graphics accelerators
installed in the master can also be used in conjunction with Sun XVR-4000 graphics
accelerators installed in the slaves.
1



The Sun Fire Visual Grid software implements a pseudo-frame-buffer device on a
master host that acts as a proxy for a physical frame buffer device on a remote Sun
Fire V880z slave host. One or more remote slave hosts are connected to the master
host in such a way that the remote frame buffers on the slave hosts appear to
existing APIs (Application Program Interfaces, such as X Windows, Sun OpenGL®

1.3 for Solaris, and Java 3D™) and application software as if they were local frame
buffer devices on the master host.

In complex display environments, up to 16 slave computers can be connected to the
master computer, each with one or two remote Sun XVR-4000 graphics accelerators,
each of which could drive two monitors or projectors, for a total of 64. For
configurations beyond the limits listed in “Supported Configurations” on page 14,
see Support Services at: http://www.sun.com/service/online

The Sun Fire Visual Grid interconnect for 3D graphics is a Myrinet PCI network
card. The Gigabit Ethernet is also supported for the X Windows portion of the
network.

Refer to the following documentation for detailed server hardware service
information (select “Servers” at http://www.sun.com/documentation):

� Sun Fire 6800/4810/4800/3800 Systems Service Manual (805-7363)
� Sun Fire V880 Server Service Manual (806-6597)
� Sun Fire V880 Server Owner’s Manual (806-6592)
� Sun Fire V880z Server and Sun XVR-4000 Graphics Accelerator Installation and User’s

Guide (817-2400)

Installation Kit
The Sun Fire Visual Grid system installation kit includes:

� Sun Fire Visual Grid software CD
� Myrinet network cards (six for each networked slave system)
� Myrinet networking cables (three for each slave)
� USB card (included if the installation includes a Sun Fire 4800/6800)
� Sun Fire Visual Grid System Installation and User’s Guide, this document

The Sun Fire Visual Grid system uses the Sun XVR-4000 graphics accelerator to
render the system graphics. If necessary, for the latest Sun XVR-4000 graphics
accelerator CD and software patches, go to:

http://sunsolve.sun.com
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Installation Process Overview
1. Verify the Sun Fire Visual Grid system software requirements (Chapter 2).

2. Verify the hardware and network requirements (Chapter 3).

3. Verify that the site is properly prepared for the hardware installation and
establish an administration workstation (Chapter 4, “Site Hardware Preparation”
on page 18 and “Administration Workstation” on page 19).

4. Set up an Ethernet network for the Sun Fire Visual Grid system (Chapter 4,
“Setting Up an Ethernet Network” on page 19).

5. Install the Myrinet cards (Chapter 4, “Installing a Myrinet Card” on page 21).

6. Install a USB card, where applicable (Chapter 4, “Installing a USB Card” on
page 25).

7. Install the Sun Fire Visual Grid software (Chapter 4, “Installing the Software” on
page 27).

8. Use the dzadmin configuration tool to configure a Sun Fire Visual Grid system
(Chapter 5).

Technical Support
For assistance and other information not found in this document concerning the
Sun Fire Visual Grid system, see Support Services at:

http://www.sun.com/service/online

For the most up-to-date version of the installation and user’s guide, select “Servers”
at:

http://www.sun.com/documentation

For the latest software patches, go to:

http://sunsolve.sun.com
Chapter 1 Sun Fire Visual Grid System Overview 3
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CHAPTER 2

Sun Fire Visual Grid System
Software Requirements

This chapter describes the Sun Fire Visual Grid system software requirements.

� “Operating Environment Requirements” on page 5
� “Sun Fire Visual Grid Software Packages” on page 6
� “Sun OpenGL for Solaris Software” on page 9
� “Other Software Requirements” on page 10

Operating Environment Requirements
� Master (Sun Fire V880z): Solaris 8 2/02 operating environment, or a subsequent

compatible version of the Solaris 8 operating environment

� Master (Sun Fire 4800/6800): Solaris 8 2/02 operating environment, or a
subsequent compatible version of the Solaris 8 operating environment

� Slave (Sun Fire V880z): Solaris 8 2/02 operating environment, or a subsequent
compatible version of the Solaris 8 operating environment
5



Sun Fire Visual Grid Software Packages
TABLE 2-1 lists the Sun Fire Visual Grid software CD files and directories. The
packages are located in the cdrom/cdrom0/ directory:

TABLE 2-1 Sun Fire Visual Grid Software CD Directories

Directory (or file) name Description

License Binary Code License

Sun_Visual_Grid_Software/1.0
/Solaris_8/Packages/

Sun Fire Visual Grid software for Solaris 8 operating
environment

Sun_Visual_Grid_Software/1.0
/Solaris_8/Patches/

Sun Fire Visual Grid software patches

Java/1.4/Packages/ Sun J2SE runtime

Myrinet/1.6.4/Packages/ Myrinet drivers and software

OpenGL/1.3/Packages/ Sun OpenGL 1.3 for Solaris

Docs/ Sun Fire Visual Grid system documentation

Copyright U.S. version of copyright

FR_Copyright French version of copyright

install Product installation script

uninstall Product removal script

README Product information

README.first Important product release information
6 Sun Fire Visual Grid System Installation and User’s Guide • November 2003



Software Packages
TABLE 2-2 lists the Sun Fire Visual Grid software packages.

Software Package Locations
The Sun Fire Visual Grid software packages are located in the directories listed in
TABLE 2-3. The packages are located in the cdrom/cdrom0/ directory:

TABLE 2-2 Sun Fire Visual Grid Software Packages

Package Name Description

SUNWdz-admin Sun Fire Visual Grid Administration Tools

SUNWdz-driver-64 Sun Fire Visual Grid Device Driver (64-bit)

SUNWdz-network Sun Fire Visual Grid OpenGL connectivity libraries

SUNWdz-xwindow Sun Fire Visual Grid Window System Support

SUNWdz-runtime Sun Fire Visual Grid System Software

SUNWmyril Myrinet Network Libraries, Utilities, and Documentation

SUNWmyrir Myrinet Network System Software

SUNWmyrix Myrinet Network System Software/Device Driver (64-bit)

SUNWj3rt J2SDK 1.4 runtime environment

SUNWdz-man Sun Fire Visual Grid man pages

TABLE 2-3 Location of Sun Fire Visual Grid Software Packages

Software Packages Directory Location

Solaris 8 software Sun_Visual_Grid_Software/1.0/Solaris_8/Packages/

Sun J2SE runtime Java/1.4/Packages/

Myrinet drivers and software Myrinet/1.6.4/Packages/

Sun OpenGL 1.3 for Solaris OpenGL/1.3/Packages/
Chapter 2 Sun Fire Visual Grid System Software Requirements 7



Software Patches
TABLE 2-4 lists the Sun Fire Visual Grid software patches required; these are all
installed automatically by the Sun Fire Visual Grid software install script. The
Solaris 8 operating environment patch bundle found on the Sun patch web site
(http://sunsolve.sun.com) may have newer versions of these patches, which
are preferable.

The patches are located in the following directory:
cdrom/cdrom0/Sun_Visual_Grid_Software/1.0/Solaris_8/Patches/

TABLE 2-4 Patches for the Solaris 8 Operating Environments

Patches Installation

110380-04 Automatically installed by the Sun Fire Visual Grid install script.

110934-10 Automatically installed by the Sun Fire Visual Grid install script.

110842-08 Automatically installed by the Sun Fire Visual Grid install script.

109896-21 Automatically installed by the Sun Fire Visual Grid install script if the
computer is a Sun Fire 4800 or Sun Fire 6800. A kernel patch update is also
installed since it is a prerequisite to this patch. The Sun Fire V880z does not
require this patch.

108652-74 Automatically installed by the Sun Fire Visual Grid install script.
8 Sun Fire Visual Grid System Installation and User’s Guide • November 2003
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Sun OpenGL for Solaris Software
The Sun Fire Visual Grid software is supported in Sun OpenGL Version 1.3, and
subsequent compatible Sun OpenGL versions, for Solaris operating environments.
Each computer in the Sun Fire Visual Grid system requires this version of Sun
OpenGL for Solaris. These software packages are bundled and automatically
installed as part of the Sun Fire Visual Grid software. Two OpenGL 1.3 patches are
also required; these are also bundled and automatically installed as part of the Sun
Fire Visual Grid software.

Sun OpenGL for Solaris Software Packages
TABLE 2-5 lists the Sun OpenGL 1.3 for Solaris software package names and
descriptions. The packages are located in the following directory:
cdrom/cdrom0/OpenGL/1.3/Packages/

TABLE 2-5 Package Names for Sun OpenGL Version 1.3

Package Name Description

SUNWgldoc Sun OpenGL for Solaris Documentation and Man Pages

SUNWgldp Sun OpenGL for Solaris Device Pipeline Support

SUNWgldpx Sun OpenGL for Solaris 64-bit Device Pipeline Support

SUNWglh Sun OpenGL for Solaris Header Files

SUNWglrt Sun OpenGL for Solaris Runtime Libraries

SUNWglrtu Sun OpenGL for Solaris Platform Specific Runtime Libraries

SUNWglrtx Sun OpenGL for Solaris 64-bit Runtime Libraries

SUNWglsr Sun OpenGL for Solaris Runtime Generic Software

SUNWglsrx Sun OpenGL for Solaris 64-bit Optimized SW Rasterizer

SUNWglsrz Sun OpenGL for Solaris Optimized SW Rasterizer
Chapter 2 Sun Fire Visual Grid System Software Requirements 9



Sun OpenGL for Solaris Patches
TABLE 2-6 lists the directory locations of the Sun OpenGL for Solaris software
packages. The packages are located in the cdrom/cdrom0/ directory

Updated versions of Sun OpenGL for Solaris are available at:
http://www.sun.com/software/graphics/OpenGL/

Other Software Requirements
Each Sun Fire Visual Grid computer containing a Sun XVR-4000 graphics accelerator
requires all of the Sun XVR-4000 graphics accelerator software installed. See the Sun
Fire V880z Server and Sun XVR-4000 Graphics Accelerator Installation and User’s Guide.

Each computer also requires a Java™ Runtime Environment (JRE) version 1.4 or
1.4.x, where x is any version number. The JRE version 1.4 is bundled with the Sun
Fire Visual Grid software; if a JRE version 1.4.X is not found on the target system, it
is automatically installed during the software installation process. If a correct
version of the JRE is found already installed on the target system, the bundled JRE
will not be installed; the Sun Fire Visual Grid software will automatically use the
already installed JRE.

Note – Each computer must have the same version of the Sun Fire Visual Grid
software packages running on it. If not, the dzadmin tool generates an error.
Upgrade the Sun Fire Visual Grid software on each computer.

TABLE 2-6 Location of Sun OpenGL for Solaris Software Patches

Software Patches Directory Location

Sun OpenGL 1.3 patch (32-bit) OpenGL/1.3/Packages/113886-15

Sun OpenGL 1.3 patch (64-bit) OpenGL/1.3/Packages/113887-15
10 Sun Fire Visual Grid System Installation and User’s Guide • November 2003
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CHAPTER 3

Sun Fire Visual Grid System
Hardware Requirements

This chapter describes the Sun Fire Visual Grid system hardware requirements and
supported system configurations.

� “Graphics Accelerator Hardware” on page 11
� “Network Hardware” on page 12
� “Supported Configurations” on page 14

See the diagrams in “System Configuration Examples” on page 16 for examples on
hardware networking configurations.

Graphics Accelerator Hardware
Only the Sun XVR-4000 graphics accelerator is supported by the Sun Fire Visual
Grid system. A system can have other frame buffers installed; they cannot, however,
be used in conjunction with the Sun Fire Visual Grid software.
11



Network Hardware
Each slave must be connected to the master by at least two separate networks—a
Gigabit Ethernet network connection for X protocol data and a Myrinet network for
OpenGL data. The Ethernet connection can pass through a switch, but the Myrinet
connections must be point-to-point. For security and performance reasons, consider
isolating the Sun Fire Visual Grid system Gigabit Ethernet network from the main
corporate network (see Chapter 6).

Sun Fire Visual Grid software includes software that aggregates bandwidth across
three point-to-point Myrinet links between the master host and each slave host. This
makes it possible to increase bandwidth beyond what is possible for a single
Myrinet card. A total of six Myrinet cards are required for each slave—three are
installed in the slave computer and three in the master computer. A Myrinet fiber
cable is used to attach each pair of Myrinet cards in point-to-point fashion, without
a network switch; therefore, three Myrinet cables are required between each master
and slave. The Myrinet cards and cables are part of the installation kit (“Installation
Kit” on page 2).

Note – The Gigabit Ethernet gear (if required) or cables are not included as a
standard part of the Sun Fire Visual Grid installation kit.

Myrinet Networking Cards
� Every slave must have exactly three Myrinet PCI network cards, and they should

be plugged into the same distribution of 66/33 Mhz PCI bus slots.

� For a Sun Fire 4800/6800 master, each slave must be connected to a separate I/O
assembly on the master.

� Myrinet connections must be point-to-point; a Myrinet switch is not supported at
this time.

� Myrinet driver packages for Solaris that are delivered as part of the Sun Fire
Visual Grid software distribution must be installed. The installation script
performs this installation automatically.

Note – Do not download the Myrinet driver packages directly from the Myricom
web site.
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� Do not install other non-Sun Myrinet cards in any of the master or slaves. The
only exception would be installation in a separate system domain in a Sun Fire
4800/6800 master.

Myricom Myrinet Card Requirements
� Six Myrinet-2000-Fiber/PCI interface PCI short cards (Myricom part no.

M3F-PCI64C-2) for each slave computer. Three are for the slave and three are for
the master.

� Myrinet-2000-Fiber cables (50/125 multimode fiber pairs with LC connectors) 25
meters in length (Myricom part no. M3F-CB-25M) for each slave computer. If
necessary for a particular installation configuration, longer cable lengths should
function without problems.

Ethernet Networking Cards
� A Gigabit Ethernet network for the master-slave connection is required. Any

Sun-supported Gigabit Ethernet network card is acceptable.

� Sun standard Gigabit Ethernet network cards are supported.

� Each slave has a built-in fiber Gigabit Ethernet adapter.

USB Card
For a Sun Fire 4800/6800 master, you must install a USB card into one of the PCI
slots so that the keyboard and mouse can be attached. This keyboard and mouse is
used when running X Windows. The Sun Fire V880z already has USB ports for a
keyboard and mouse.

A USB card that fits into a Sun Fire 4800/6800 PCI slot is included in the Sun Fire
Visual Grid system installation kit. The USB card is only supported for a keyboard
and mouse, and other USB 1.0 and USB 1.1 functionality. USB 2.0 is not officially
supported with this card, although it should function properly.

Serial Port
For a master Sun Fire 4800/6800, you can obtain serial port capability by using an
Edgeport Standard Serial Converter (Edgeport model number 301-1000-04), which is
a USB-to-RS232 serial converter.
Chapter 3 Sun Fire Visual Grid System Hardware Requirements 13



Keyboard, Video, and Mouse Extenders
A keyboard and mouse extender device is required for a Sun Fire 4800/6800.
Otherwise, the keyboard and mouse cables will not reach far enough to connect to
that computer. Some installations might also need video extenders, which provide
remote access to the video some distance away from a Sun Fire V880z, typically over
fiber links. This equipment must be purchased separately and is not included in the
Sun Fire Visual Grid system installation kit. For help obtaining the equipment,
contact your Sun service representative.

Supported Configurations
TABLE 3-1 lists the supported system configurations. For networking diagram
examples, see “System Configuration Examples” on page 16.

For configurations beyond the limits in TABLE 3-1, see Support Services at:

http://www.sun.com/service/online

Sun Fire 4800 and Sun Fire 6800 Configurations

For Sun Fire 4800 and Sun Fire 6800 Visual Grid configurations only, the single Sun
XVR-4000 graphics accelerator option enables configurations with an odd number of
frame buffers. In this configuration, however, you can only have one Sun Fire V880z
slave with one Sun XVR-4000 graphics accelerator.

TABLE 3-1 Supported Configuration Summary

Master Computer Slave Computer

Sun Fire V880z with one Sun XVR-4000 graphics
accelerator (4-6 CPUs)

One Sun Fire V880z with two Sun XVR-4000 graphics
accelerators (2 CPUs)

Sun Fire V880z with two Sun XVR-4000 graphics
accelerators (4 CPUs)

One Sun Fire V880z with two Sun XVR-4000 graphics
accelerators (2 CPUs)

Sun Fire 4800 Up to two Sun Fire V880z computers with one or two
Sun XVR-4000 graphics accelerators (2 CPUs)

Sun Fire 6800 Up to four Sun Fire V880z computers with one or two
Sun XVR-4000 graphics accelerators (2 CPUs)
14 Sun Fire Visual Grid System Installation and User’s Guide • November 2003
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CHAPTER 4

Installing the Sun Fire Visual Grid
System

This chapter describes how to install the Sun Fire Visual Grid system.

� “System Configuration Examples” on page 16
� “Site Hardware Preparation” on page 18
� “Installing a Myrinet Card” on page 21
� “Installing a USB Card” on page 25
� “Installing the Software” on page 27
� “Upgrading the Sun Fire Visual Grid Software” on page 32
� “Interchanging a Master and Slave” on page 34
� “Configuring the Frame Buffer Attributes” on page 36
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System Configuration Examples
FIGURE 4-1 shows an example of a Sun Fire Visual Grid system networked
configuration for one Sun Fire 6800 master and two slaves.

FIGURE 4-1 Configuration of One Sun Fire 6800 Master and Two Slaves
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FIGURE 4-1 shows an example of a Sun Fire Visual Grid system networked
configuration for one Sun Fire V880z master and one slave.

FIGURE 4-2 Configuration of One Sun Fire V880z Master and One Slave
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Site Hardware Preparation
You need to complete specific hardware prerequisites for a Sun Fire Visual Grid
system installation before attempting to go through the software installation
procedure. These requirements are described below:

Note – All of the following necessary items must be in place before proceeding with
the Sun Fire Visual Grid software installation procedure.

� Make sure that there is an administration workstation available during the
installation process which has network access to the master computer.

The administration workstation should be a separate computer from the master
and slaves. It should be capable of running X Windows and have remote access
(rsh or rlogin) to the master. The master should have remote access (rsh or
rlogin) to each slave. The administration workstation should be able to log into
both master and slaves. See “Administration Workstation” on page 19.

� Configure the Gigabit Ethernet network on the master and slave computers,
ensuring that each slave can be reached through a ping from the master over the
gigabit link, and vice versa.

See “Setting Up an Ethernet Network” on page 19.

� Install the Myrinet cards into the master and each slave. Properly cable the
Myrinet cards from the master to each of the cards in the slaves.

See “Installing a Myrinet Card” on page 21. Until the Myrinet drivers are installed
during the software installation process, the Myrinet boards are “invisible” to the
systems. See “Verifying the Myrinet Software” on page 55.

� If the master does not have USB ports, as in the case of a Sun Fire 4800 or Sun Fire
6800, you must install a USB card in the master for the keyboard and mouse.

Installing a USB card is not necessary with a Sun Fire V880z, because it already
provides USB ports for the keyboard and mouse. See “Installing a USB Card” on
page 25.

� Install the appropriate hardware to co-locate the master (host) keyboard and
mouse remotely with the displays, if this is going to be a part of the final
installation.

This is required for a Sun Fire 4800 or Sun Fire 6800 installation because without
extender hardware the keyboard and mouse do not reach the displays. See
“Keyboard, Video, and Mouse Extenders” on page 14.
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Administration Workstation
A separate workstation is required to administer the Sun Fire Visual Grid software
during system installation. This administration workstation must be on the same
network as the master in the Sun Fire Visual Grid system configuration (see “System
Configuration Examples” on page 16). The administration workstation is used to run
the software administration tool, dzadmin, to configure the grid (see Chapter 5).

Setting Up an Ethernet Network
Using a Gigabit Ethernet network is required for better X Window performance. The
Sun Fire Visual Grid system has built-in fiber Gigabit Ethernet hardware.

Note – These instructions provide a simple method to configure a Gigabit Ethernet
network local to the Sun Fire Visual Grid system. If you prefer that your network
administrator configure the network instead of using these instructions, contact your
Sun service representative.

For each master and slave on the network, take the following steps:

1. Determine which IP network addresses to use for the Gigabit Ethernet.

If the systems are already on a corporate network, then the Gigabit Ethernet network
should be on a different subnet. For simplicity, you may want to use a different class
B address. For example, if the system is on the corporate network as 195.131.45.155,
you might choose the Gigabit Ethernet address somewhere in 195.132.*.*. Each
associated master/slave Gigabit Ethernet connection should have the same class B
address (for example, 195.132.*.*). If there is a switch handling the Gigabit Ethernet
network between the master and slave systems, then each system in the Sun Fire
Visual Grid system installation can share the same class B address space on the
Gigabit Ethernet network. When there are multiple master/slave point-to-point
Gigabit Ethernet connections (for example, a switch is not being used between the
master and slave machines and there is more than one slave machine), you must
assign a different class B address space to each master/slave pair.

2. Add the Gigabit Ethernet name and IP address of all master and slaves on this
subnetwork to the /etc/hosts file of each system.
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3. Create a file /etc/hostname.xxx, where xxx is the name of the Gigabit Ethernet
port.

On a Sun Fire V880z, the built-in Gigabit Ethernet port is ge0, therefore, the file is
/etc/hostname.ge0. On a Sun Fire Enterprise class server, the port may be gen or
cen depending on the adapter type.

The /etc/hostname.xxx file should contain a single line with the name of this
server on the Gigabit Ethernet network. This name should be unique from the
nodename or any other network name of this server. So the master machine might
be called “master” and each slave “slaven”, where n is the slave number.

4. Create the file /etc/notrouter. Type:

The file has no contents.

5. Edit the /etc/nsswitch.conf file to check the local hosts file first.

For example, if /etc/nsswitch.conf is configured for nis, find the line:

Edit the line to read:

6. Enable the Gigabit Ethernet port.

To do this, reboot the server.

7. Verify the installation.

Using the example nodenames above, it should be possible to use the ping master
command from each slave, and the command ping slaven for each slave from the
master. Use the ifconfig -a command on each master/slave computer to display
the Gigabit Ethernet adapter.

# touch /etc/notrouter

hosts: nis [NOTFOUND=return] files

hosts: files nis [NOTFOUND=return] files
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Installing a Myrinet Card
This section provides information for installing the Myrinet hardware and software.

The following describes how to install the Myrinet PCI cards into a Sun Fire
4800/6800 and a Sun Fire V880z.

Installing the Myrinet PCI Cards in a
Sun Fire 4800/6800
On a Sun Fire 4800/6800, the Myrinet cards attached to a particular slave must be
completely contained within one I/O assembly. The PCI slots are numbered on the
side of the I/O assembly boat, and the PCI busses are marked as well. There are two
PCI busses that feed into the PCI slots. Install the three cards so that at least one of
them is attached to each of the two PCI buses.

The power requirement of a Myrinet card is approximately 11 Watts.

See the Sun Fire 6800/4810/4800/3800 Systems Service Manual for procedures on how
to shut down these systems safely before installing or removing any internal boards,
and how to reboot the system after installation.

1. Shut down your system and remove the Sun Fire 4800/6800 PCI I/O assembly.

a. Loosen the four I/O assembly captive Phillips screws and pull the ejector levers
outward (FIGURE 4-3).

b. Slide out the I/O assembly and place it on an ESD mat close to the system.

2. Attach the antistatic wrist strap to your wrist and connect the strap to the I/O
assembly.

3. Lay the I/O assembly on its side.

Locate the PCI slot numbers where the Myrinet cards are to be installed.

4. Position the Myrinet card in the I/O assembly (FIGURE 4-3).

5. Guide the Myrinet card into the I/O assembly PCI slot (slot 7 in this example)
(FIGURE 4-3).

a. Insert the faceplate end of the Myrinet card into the appropriate opening in the
I/O assembly back panel.

b. Guide the opposite end of the Myrinet card into the card slot.
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c. Secure the faceplate to the I/O assembly with the two Phillips screws.

FIGURE 4-3 Installing a Myrinet PCI Card in the Sun Fire 6800 I/O Assembly

6. Insert and secure filler boards into any other open slots.

7. Replace the I/O assembly into the Sun Fire 4800/6800 chassis.

a. Line up the I/O assembly with the chassis I/O assembly opening and slide the
assembly into the chassis.

b. Simultaneously press the two ejector levers inward. Then tighten the four
captive Phillips screws snugly by hand.

8. Install the Myrinet cards in the Sun Fire V880z.

See “Installing the Myrinet PCI Cards in a Sun Fire V880z” on page 23.

Note – When the Sun Fire Visual Grid software is installed, the Myrinet cards are
recognized by the Myrinet software bundled with Sun Fire Visual Grid software.

Ejector levers (2)

Captive
screws (4)

Myrinet card

Sun Fire 6800
I/O assembly
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Installing the Myrinet PCI Cards in a
Sun Fire V880z
On a Sun Fire V880z that is powered down, install each Myrinet card in a separate
PCI bus. The Sun Fire V880z has nine PCI slots and three PCI buses. The PCI slots
are numbered from the bottom up, starting at 0 and ending at 8. The numbering
scheme can be found on the inside of the left door that closes over the PCI slots.

Refer to the following hardware documentation for detailed installation and service
information:

� Sun Fire V880 Server Service Manual (806-6597)
� Sun Fire V880 Server Owner’s Manual (806-6592)

1. Identify the slots where you want to install the Myrinet cards.

One card should be installed in one of the PCI slots numbers 0-3 (33 MHz bus), one
installed into one of the PCI slots numbered 4-6 (33 MHz bus), and one installed into
one the PCI slots numbered 7-8 (66 MHz bus). The 66 MHz slots are physically the
highest two PCI slots.

2. Remove the PCI filler panel from the back of the system.

a. Pinch the PCI card retaining clip until it releases from the top of the filler panel
and rotate the clip outward.

b. Slide the filler panel out from the rear panel.

FIGURE 4-4 Installing Myrinet Cards in the Sun Fire V880z

Myrinet card

Sun Fire V880z
serverPCI slot 0
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3. Insert the Myrinet cards into the appropriate slots on the I/O board (FIGURE 4-4).

a. Insert the faceplate side of the Myrinet card into the appropriate opening on
the rear panel. At the same time, insert the other end of the card into the
corresponding groove on the PCI card bracket.

b. Push the card into the slot on the I/O board until the card is fully seated.

Cabling the Master and Slaves
� Connect one end of each Myrinet networking fiber cable (three cables per slave)

from each Myrinet card in the master to a Myrinet card in the slave.

There are six Myrinet cards for each networked slave—three in the master, three in
the slave.

Ensure that the fiber cables connecting the master with each Myrinet card in each
slave are properly attached. All connections are point-to-point and there is no
network switch involved. See “System Configuration Examples” on page 16.

When cabling the Myrinet cards, the green LED on the cards illuminates once a
connection is established over the fiber cabling. If the LED does not light and both
master and slave computers are powered on, then there is a problem with the fiber
cables, the connection, or device seating.

Note – You must only use the Myrinet drivers bundled with the Sun Fire Visual
Grid software. Do not use other Myrinet drivers, such as Myrinet drivers available
on Myricom’s web site. See “Verifying the Myrinet Software” on page 55.
24 Sun Fire Visual Grid System Installation and User’s Guide • November 2003



Installing a USB Card
This procedure only applies to the Sun Fire 4800/6800. Installing a USB card is not
necessary with a Sun Fire V880z, since it already provides USB ports for the
keyboard and mouse. The USB card can be installed into any PCI slot.

Refer to the Sun Fire 6800/4810/4800/3800 Systems Service Manual (805-7363) for
proper procedures on how to shut down the computer safely before installing or
removing any internal boards and how to reboot after installation. For a complete set
of documentation, select “Servers” at: http://www.sun.com/documentation

Installing a USB Card in a Sun Fire 4800/6800

1. Shut down your system and remove the Sun Fire 4800/6800 PCI I/O assembly.

Refer to the Sun Fire 6800/4810/4800/3800 Systems Service Manual for details on
removing and replacing PCI I/O assemblies.

a. Loosen the four I/O assembly captive Phillips screws and pull the ejector levers
outward (FIGURE 4-5).

b. Slide out the I/O assembly and place it on an ESD mat close to the system.

2. Attach the antistatic wrist strap and connect it to the I/O assembly.

3. Place the I/O assembly on its side.

4. Position the USB card in the I/O assembly (FIGURE 4-5).

5. Guide the USB card into the I/O assembly slot 7 (FIGURE 4-5). Choose any available
slot for the card.

a. Insert the faceplate end of the USB card into the appropriate opening in the I/O
assembly back panel.

b. Guide the opposite end of the USB card into the card slot.

c. Secure the faceplate to the I/O assembly with the two Phillips screws.
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FIGURE 4-5 Installing a PCI USB Card in the Sun Fire 6800 I/O Assembly

6. Insert and secure filler boards into any other open slots.

7. Replace the I/O assembly into the Sun Fire 4800/6800 chassis.

a. Line up the I/O assembly with the chassis I/O assembly opening and slide the
assembly into the chassis.

b. Simultaneously press the two ejector levers inward and tighten the four captive
Phillips screws snugly by hand.

Note – In order for the USB PCI card to be recognized by Solaris 8 update 7, you
must always reboot the Sun Fire 4800/6800 with the -r flag.
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Captive
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PCI USB card

Slot 7 Sun Fire 6800
I/O assembly
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Installing the Software
This section is for first time setup only. Please make sure that you have completed
the site preparation requirements (“Site Hardware Preparation” on page 18) before
proceeding further.

Note – Once the Sun Fire Visual Grid system hardware and software are installed
and configured for the first time, upgrading the software is simple. The process is
detailed in “Upgrading the Sun Fire Visual Grid Software” on page 32.

1. If necessary, install the correct version of the Solaris operating environment on
each system and upgrade to the proper Solaris operating environment patch level.

See “Operating Environment Requirements” on page 5 and “Software Patches” on
page 8 in Chapter 2.

Note – The patches required for Sun Fire Visual Grid system are automatically
installed when you run the install script (this is a later step). Refer to the Sun Fire
V880z Server and Sun XVR-4000 Graphics Accelerator Installation and User’s Guide for
Sun XVR-4000 graphics accelerator software installation procedures.

2. Before starting the software installation, verify that each slave can bring up the X
Window system.

For example, log in and start an X Window session (for example, CDE or GNOME)
on each Sun XVR-4000 graphics accelerator. A keyboard and mouse be plugged into
the USB ports of each slave system, even after the Sun Fire Visual Grid software
installation is complete. If not, the X server on the slaves will not be able to start.

If necessary, upgrade to the latest Sun XVR-4000 graphics accelerator drivers. See the
Sun Fire V880z Server and Sun XVR-4000 Graphics Accelerator Installation and User’s
Guide for instructions. Sun OpenGL for Solaris software is bundled with the Sun Fire
Visual Grid software.

3. Become superuser and set the frame buffer attributes to the same values for each
Sun XVR-4000 graphics accelerator in each system.

Note – This step is required only if you plan to run your system in Xinerama mode.
If not, this step is optional.

If you run your system in Xinerama mode, the frame buffer attributes must be set to
the same values for each Sun XVR-4000 graphics accelerator in each system. To do
this, type the following on each master and slave that has a Sun XVR-4000 graphics
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accelerator installed:

Where zulun refers to zulu0, zulu1, and so on, as the devices appear in the
/dev/fbs directory on each computer.

This step is to ensure that the frame buffers are all set with the same properties.
Later, after the installation is complete, these settings can be customized for the
particular installation.

4. On each slave, make the master the loghost for the slave by modifying the slave
system /etc/hosts file. Also, modify the /etc/syslog.conf file on each slave
so that the console output is redirected to the master console output.

If you do not modify these two files, the slave console output is written on the
screen, obscuring the window system when this slave is run as a Sun Fire Visual
Grid slave computer. See “Redirecting the Slave Console Output” on page 31.

5. Remotely log in to each slave and run the following:

These commands bring down the login screen if it is currently running. These
commands cause the login screen for the X Window system not to come up
automatically whenever the X Window system is exited or when the Sun Fire Visual
Grid system comes up after a reboot. The login screen is not necessary on the slave
since the master initiates the X Window system on the slave.

6. Install the software packages on the master and on each slave.

For Sun Fire 4800/6800 computers:

a. Insert the Sun Fire Visual Grid software CD into the CD-ROM drive, become
superuser, go to the following directory and install the required patches. Type:

b. Reboot.

c. Install the Sun Fire Visual Grid software. Type:

# fbconfig -dev /dev/fbs/zulun -defaults

# /usr/dt/bin/dtconfig -d
# /usr/dt/bin/dtconfig -kill

# cd /cdrom/cdrom0/
# ./install_patches

# ./install
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d. Respond to the installation prompts.

You need to know whether you are installing the software on a master or slave.

For Sun Fire V880z computers:

a. Insert the Sun Fire Visual Grid software CD into the CD-ROM drive, become
superuser, go to the following directory and install:

b. Respond to the installation prompts.

You need to know whether you are installing the software on a master or slave.

7. Reboot the master and each slave.

No special boot flags are required on a Sun Fire V880z. The Sun Fire 4800/6800,
however, requires the -r flag for the boot command to recognize the PCI USB board.

8. With the dzadmin software administration tool, create your system configuration
and install it on the master.

You should remotely log in (rlogin) to the master computer from the
administration workstation and then run dzadmin. When you are finished with this
step, exit the dzadmin tool. Carefully follow the directions the first time using this
tool.

See “dzadmin Administration Tool” on page 37.

9. Modify /etc/dt/config/Xservers on the master to match the multi-display
installation created in the administration tool (dzadmin).

The Xservers file controls on what frame buffers X Windows appears. The
dzadmin tool appends a string to the end of the /etc/dt/config/Xservers file
when the dzadmin install button is pushed. Uncomment that line by removing the
pound sign (#) in front of it; comment out the old entry by adding a “#” in front of
it. Every installation with the dzadmin tool appends a new commented-out X
servers string to the end of the Xservers file.

Note – The Xservers file on the slave system is always ignored by the software.

See the Sun Fire V880z Server and Sun XVR-4000 Graphics Accelerator Installation and
User’s Guide for more details on how to modify the Xservers file.

# cd /cdrom/cdrom0/
# ./install
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10. Bring up the window system login screen in Sun Fire Visual Grid mode.

If the window system is running on the master, log out of the session.

On the master, from a remote shell, run the following as superuser:

The window system is reset to the new settings. The X window login screen should
now appear. (The command-line output from dzstartup might list an error
condition; ignore this message.)

11. On the master, log in through the X Window login screen.

After the window system appears across the frame buffers, run an OpenGL program
on each display to verify the installation.

For example, type the following:

If the window system is running in Xinerama mode, there is only one logical display,
which enables you to move the program window across the different displays. In a
non-Xinerama installation, separately test each display.

Installation is now complete.

See Appendix A, Troubleshooting, or contact your Sun service representative if
installation problems occur:

http://www.sun.com/service/online

# /usr/sbin/dzstartup start
# /usr/dt/bin/dtconfig -reset

% setenv DISPLAY :0.0
% /usr/openwin/demo/GL/ogl_install_check
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Redirecting the Slave Console Output
On each slave, modify the /etc/syslog.conf file so that the output from the
console goes to the master console output. If this is not done, console messages
appear on the slave screen, obscuring rendering. Modify the /etc/syslog.conf
file on each slave as follows.

1. Comment (#) the following line in the file:

# *.err;kern.notice;auth.notice /dev/sysmsg

2. Add the following line to the file right after the commented out line:

*.err;kern.notice;auth.notice @loghost

3. Comment (#) the following line in the file:

# user.err /dev/sysmsg

4. Add the following line to the file right after the commented out line:

user.err @loghost

Ensure that the line being replaced is a comment. Add the additional line after the
replaced line as shown is this sample /etc/syslog.conf file:

On each slave, designate the master as the loghost. Modify the /etc/hosts file
by removing the loghost notation from the slave line to the master line, and by
making the master the loghost. Ensure that there is a line in the /etc/hosts file
that contains the master IP address. This line should have been added during the
Gigabit Ethernet network installation process.

Example original /etc/hosts file:

# *.err;kern.notice;auth.notice    /dev/sysmsg
*.err;kern.notice;auth.notice   @loghost
# user.err /dev/sysmsg
user.err @loghost

127.0.0.1 localhost
10.5.28.254 slavehost loghost
11.5.28.254 dzslave0 ## slave gigabit ethernet
11.5.28.28 dzmaster ## master gigabit ethernet
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Example modified /etc/hosts file:

These changes, combined with the /etc/syslog.conf change described earlier in
this section, redirects each slave console output to the master in the
/var/adm/messages file.

For these changes to take effect, reboot the slave, or more preferably, run the syslog
script as superuser in /etc/init.d:

See Appendix A for troubleshooting information.

Upgrading the Sun Fire Visual Grid
Software
If the Sun Fire Visual Grid software is being installed for the first time, follow the
procedures in “Site Hardware Preparation” on page 18 and “Installing the Software”
on page 27. If you are upgrading the software in an existing Sun Fire Visual Grid
software installation, follow the directions in this section.

The Sun Fire Visual Grid software packages are specific to the Solaris 8 operating
environment. The installation script automatically detects the operating environment
and installs the correct packages and patches. In addition to Sun Fire Visual Grid
software, these packages automatically install the correct version of OpenGL 1.3, a
recent OpenGL 1.3 patch, a Java 1.4 runtime environment, and the drivers for the
Myrinet cards, as necessary. The entire release is bundled into a single executable
that is run from the command line and is menu driven.

Note – Install the software upgrade from the command line and not while the Sun
Fire Visual Grid software window system is running.

127.0.0.1 localhost
10.5.28.254 slavehost
11.5.28.254 dzslave0 ## slave gigabit ethernet
11.5.28.28 dzmaster loghost ## master gigabit ethernet

# /etc/init.d/syslog stop
# /etc/init.d/syslog start
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1. Insert the Sun Fire Visual Grid software CD into the CD-ROM drive, become
superuser, go to the following directory, and type:

Respond to the installation prompts. You need to know whether you are installing
the software on a master or slave.

If a trustedhosts file already exists on the systems for security reasons (see
Chapter 6), the script acknowledges this and retains the trustedhosts settings.

Note – All master and slave computers must be upgraded. If only a subset of the
machines are upgraded, and an attempt is made to run the Sun Fire Visual Grid
software, the software issues an error message at run time and exit.

To remove previously installed Sun Fire Visual Grid software packages, use the
./uninstall command, and respond to the removal prompts. An uninstall
completely removes the previous installation. However, the install script only
installs components that have been updated since the last release, and does not
reinstall the other components on the computer.

2. After completing the installation, reboot each master and slave.

Previous state settings, such as an installed system configuration file, remain in
effect from release to release. The system should just appear with the previous
settings after the software upgrade.

# cd /cdrom/cdrom0

# ./install
Chapter 4 Installing the Sun Fire Visual Grid System 33



Interchanging a Master and Slave
In some complex configurations, it might be desirable to use the same computer
interchangably as a master and a slave.

Select the master option when installing software on any computer that may be a
master computer, even if it will initially serve as a slave computer. You select master
or slave when responding to the software installation script. See Step 6 in “Installing
the Software” on page 27.

Modify the trustedhosts file (/etc/openwin/dz/trustedhosts) on each
computer to contain all the hosts that may be required. Or, alternatively, remove the
trustedhosts file on a computer to enable any computer to administer/control it.

On a slave computer, the trustedhosts file, at a minimum, contains “localhost”
and the Gigabit Ethernet hostname of the master computer. On a master, it contains,
at a minimum, “localhost” and the output of uname -n on the master. The union of
these names is required for a computer’s trustedhosts file to be either a master or
a slave.

Run the following command sequences from the administration workstation.

Changing a Master to a Slave Computer
To stop a computer from being a master (if you are changing master computers), do
the following steps.

1. On the master computer, type:

Where backup file is the filename you selected as the backup file.

2. Perform any necessary Myrinet recabling after you have executed the above
commands.

3. Once a computer is no longer a master, you can add it as a slave to another master
computer by running dzadmin on the new master.

# /etc/init.d/dtlogin stop (stops the X server)
# /usr/sbin/dzstartup stop (stops the Sun Fire Visual Grid service)
# mv /etc/openwin/dz/system.dzcfg backup file
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4. Once the new configuration is complete in dzadmin, select Actions -> Configure
Myrinet Hardware from the administration tool Actions menu.

This automatically reconfigures the Sun Fire Visual Grid system to the new Myrinet
hardware setup. See “The System Administration Tool Menus” on page 41 for a
description of the menus.

5. Select Install to install the configuration.

Manually update the /etc/dt/config/Xservers file on the new master
computer. Occasionally, you may need to reboot any computer that was part of the
Myrinet recabling before dzadmin successfully installs a new installation on the new
master computer.

6. Verify that the old master computer is no longer designated as a master.

To do this, run /usr/sbin/dzstatus on the old master computer.

Removing a Slave Computer
To stop a computer from being a slave, do the following steps. Perform this if you
are keeping the same master computer but removing or changing slave computers:

1. On the master computer, type:

2. Perform any necessary Myrinet recabling after you have executed the above
commands.

3. Run dzadmin on the master computer and remove this slave computer from the
configuration.

4. Select Install to install the configuration.

Manually update the /etc/dt/config/Xservers file on the master.

5. Run dzstartup start.

6. Restart X window by running /etc/init.d/dtlogin start.

Occasionally, you may need to reboot any computer that was part of the Myrinet
recabling before dzadmin successfully installs a new installation on the new master
computer.

7. Verify that the slave computer is no longer designated as a slave.

To do this, run /usr/sbin/dzstatus on the slave computer.

# /etc/init.d/dtlogin stop

# dzstartup stop
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Configuring the Frame Buffer Attributes
Once a Sun Fire Visual Grid system installation has been successfully completed,
you can configure all of the remote frame buffers from the master machine. To see a
list of frame buffers recognized by the system, type the following on the master
machine:

All the frame buffers with dzfb in the name are Sun Fire Visual Grid frame buffers.
The following command lists the properties of the first Sun Fire Visual Grid frame
buffer:

The following command lists the possible commands:

Using fbconfig to administer a Sun Fire Visual Grid frame buffer is no different
than using fbconfig to administer a local Sun XVR-4000 graphics accelerator. Most
fbconfig changes require restarting the X server. Log out of the X Window system
on the master and log back in. The Sun Fire Visual Grid software automatically
restarts the X server on the slaves during this process.

When a slave is running in Xinerama mode, the entire slave system is addressed as a
single device from the master system (for example, dzfb0). So using fbconfig on a
single device affects both of the slave frame buffers. The fbconfig -list lists only
a single device for the slave when it is running in Xinerama mode.

Refer to the Sun Fire V880z Server and Sun XVR-4000 Graphics Accelerator Installation
and User’s Guide for details on the effect of various fbconfig commands on the Sun
XVR-4000 graphics accelerator.

# fbconfig -list

# fbconfig -dev /dev/fbs/dzfb0 -propt

# fbconfig -dev /dev/fbs/dzfb0 -help
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CHAPTER 5

System Administration

This chapter describes the dzadmin configuration tool that system administrators
use to configure a Sun Fire Visual Grid system.

� “dzadmin Administration Tool” on page 37
� “The System Administration Tool Menus” on page 41
� “Starting the dzadmin System Administration Tool” on page 43
� “Using the dzadmin System Administration Tool” on page 45
� “dzstatus Status Tool” on page 48
� “Sun Fire Visual Grid Limitations” on page 49
� “Framelock and Genlock” on page 49

dzadmin Administration Tool
The dzadmin program is the system administration configuration tool that system
administrators use to configure a Sun Fire Visual Grid system. The dzadmin tool is
a Graphical User Interface (GUI) (FIGURE 5-1).

You must run dzadmin on a Sun Fire Visual Grid system master with a slave
present. The dzadmin tool dynamically queries the master and slaves for the
available hardware; these details appear in the tool GUI. The Sun Fire Visual Grid
system achieves communication between master and slave machines by running a
network aware daemon, called dzdaemon, on each machine. dzdaemon always
comes up automatically when a system is rebooted.
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Administration Tool Overview
The Sun Fire Visual Grid system master is configured using the Master Machine
Configuration panel of the Sun Fire Visual Grid System Administration window
(FIGURE 5-1). From the dzadmin System Administration window menu system
(Actions -> Add Slave), you can add slaves to the configuration. The addition of
each slave adds a new slave panel to the Slave Machine Configurations panel. From
this panel, you can set the characteristics of each slave (FIGURE 5-1). As each slave is
added, the tool automatically queries the frame buffer information from that slave.
The information appears in the Slave Machine Configurations panel. The Messages
panel provides feedback about the tool’s progress and reports any problems.

FIGURE 5-1 Sun Fire Visual Grid Software Administration Tool

Once a configuration has been generated, you can save it as a file for later use or you
can install it onto the master for immediate operation (from either Actions menu or
pressing the Install button). Save a configuration by saving it as a user-named file.
To load a file into the GUI, select Load from the File menu (File -> Load). A newly
installed configuration becomes the default system configuration. The dzadmin tool
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overwrites the previous configuration file in /etc/dz/openwin/system.dzcfg.
To be safe, save an existing installation to a file before installing another
configuration.

The newly installed configuration takes effect after you modify the
/etc/dt/config/Xservers file and restart the existing X session. The Xservers
file determines which screens and what command line arguments the X server will
use. Once the configuration in dzadmin has changed, it is important to modify the
Xservers file before restarting the X server, or the system will not come up
properly. When the Install button was pressed on the dzadmin administration tool,
it appended a commented-out sample line to the bottom of the Xservers file that
corresponds to the particular configuration in the tool. Comment out the existing
line in the file (adding a pound sign “#” to the front of the line) and then
uncomment the newly appended line (removing # in front of the line) before
restarting the X server.

Alternatively, the following command, as superuser, causes the new configuration to
come up immediately, and causes the X server to restart if the configuration has
changed:

If the X session is being started from the command line, you must run
/usr/sbin/dzstartup start in between invocations of X sessions. That is, you
must run the start command again if the device configuration changes (for
example, if slave machines were added or deleted, or a frame buffer was added to a
slave). You also must run start if the user changes from Xinerama mode to non-
Xinerama mode or vice versa.

When you select the Install option in the Actions menu, it automatically prompts the
user to save the configuration to a user-named file. A new installation automatically
overwrites the previously installed system.dzcfg file. To recover it, refer back to
the backup file you created while installing it. To be safe, save an existing
installation to a file by saving it before installing another configuration.

master# /usr/sbin/dzstartup start
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Using Xinerama and dzadmin

In an ordinary multiscreen system without Sun Fire Visual Grid software, it is
possible to switch to or from Xinerama mode by modifying the Xservers file and
restarting the windowing system. The X servers file is located at
/etc/dt/config/Xservers. The Xservers file, if it does not already exist, is
automatically created by the Sun Fire Visual Grid software package installation.

In a Sun Fire Visual Grid system, when switching back and forth between Xinerama
and non-Xinerama mode, you must modify the Xservers file in the same way. And
you must check or uncheck the Xinerama box in the Frame Buffers panel located
within the slave panel in the dzadmin tool. This is extra step is necessary because in
Xinerama mode, Sun Fire Visual Grid software sees a pair of frame buffers in a slave
as a single device on the master. The single device displays twice the resolution of
the individual devices.

You must set the frame buffer attributes of a system running in Xinerama mode to
the same values. See “Upgrading the Sun Fire Visual Grid Software” on page 32 for
more details.
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The System Administration Tool Menus
There are two menus on the Sun Fire Visual Grid software administration tool
(dzadmin) menu bar: File and Actions.

File Menu
FIGURE 5-2 shows the File menu.

FIGURE 5-2 Sun Fire Visual Grid Software Administration Tool File Menu

TABLE 5-1 describes the File menu items.

TABLE 5-1 File Menu

Menu Item Description

New Creates a new, blank configuration file.

Open... Opens the file menu to select a particular configuration file
to load.

Open Installed Configuration Loads and displays the currently installed master
configuration.

Save Saves the configuration file to disk. This does not install the
configuration file.

Save As. Saves the configuration file to disk by a selected filename.
This does not install the configuration file.

Exit Exits the system administration tool.
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Actions Menu
FIGURE 5-3 shows the Actions menu.

FIGURE 5-3 Sun Fire Visual Grid Software Administration Tool Actions Menu

TABLE 5-2 describes the Actions menu items.

TABLE 5-2 Actions Menu

Menu Item Description

Add Slave Adds a slave to the configuration.

Remove Slave Removes a slave from a configuration.

Configure Myrinet Hardware Automatically reconfigures the Sun Fire Visual Grid system
to a new Myrinet hardware setup.

Install Installs the configuration file.

Shutdown Stops the daemon on both master and slave computers.
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Starting the dzadmin System
Administration Tool
The dzadmin tool does not make any dynamic changes to the system configuration
until the user installs the system configuration. Therefore, you can use the tool to
create new configuration profiles while the Sun Fire Visual Grid system is in use by
other users.

Run dzadmin on the master by setting the DISPLAY environment variable so that
you can become host (xhost) to the administration workstation. The application
displays on the screen of the administration workstation.

To start the dzadmin tool:

1. Become superuser and set the administration workstation DISPLAY environment
variable. Type:

Where master is the master host and admin is the name of the administration
workstation.

2. Start dzadmin. Type:

The Sun Fire Visual Grid software administration tool then appears on the
administration workstation screen (FIGURE 5-4).

admin# rlogin master
master# setenv DISPLAY admin:0.0

master# /usr/sbin/dzadmin&
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The administration tool consists of three panels: Master Machine Configuration,
Slave Machine Configuration, and Messages.

FIGURE 5-4 Sun Fire Visual Grid Software Administration Tool

3. Go to “Using the dzadmin System Administration Tool” on page 45.
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Using the dzadmin System
Administration Tool

1. Start the dzadmin administration tool

See “Starting the dzadmin System Administration Tool” on page 43.

2. Enter the master nodename in the Master Machine field.

a. Enter the master nodename, or enter localhost.

To find the master machine nodename, type:

b. Press Enter or Tab to move to the next field.

Caution – Do not enter the master Gigabit Ethernet nodename in the master field.
This can cause a security problem for secure setups.

After you fill in the Master Machine field (FIGURE 5-5), dzadmin queries the
hardware on the master computer. If a current Sun Fire Visual Grid system.dzcfg
installation file exists on this master, a dialog box appears prompting you to load it
into the tool. If the file is not installed, you will enter the information in the steps of
this procedure.

host% uname -n
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FIGURE 5-5 Master Machine Configuration Panel

Note – The X server options in the /etc/dt/config/Xservers file must be
manually edited to match the options in the dzadmin tool after the Install button
has been pressed. See Step 7.

3. Configure the X server options for the master machine.

Choose the required color depth and select Xinerama, if required. If you select
Xinerama here, all the displays are combined into one large flat X screen.
46 Sun Fire Visual Grid System Installation and User’s Guide • November 2003



4. Add the required number of slave machines one at a time.

a. From the administration tool menu bar, choose Actions -> AddSlaves.

A Slave Machine Configurations panel displays for each computer (FIGURE 5-6). A
(1) indicates the first slave, a (2) indicates the second slave, and so on.

FIGURE 5-6 Slave Machine Configuration Panel

b. In each slave panel, enter the name of the slave using its Gigabit Ethernet
nodename in the Machine Name field, and press Enter or Tab.

The hardware on the slaves is dynamically queried, and appears as configurable
options in the dzadmin tool.

c. Adjust the Slaves Machine Configuration panel as required.

For example, you may want to select color depth, Xinerama, or particular frame
buffers on the slave.

5. After you add all the slaves to the configuration, install the configuration.

Press the Install button on the Master Machine Configuration Panel (FIGURE 5-5).

Note – You are prompted to save the configuration in a user-named file as a backup
before installation. Install the new configuration, in addition to saving it to a file, or
the configuration does not take effect.
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6. Exit dzadmin. Choose File -> Exit from the administration tool menu bar.

7. Make necessary changes to the /etc/dt/config/Xservers file.

The Xservers file controls which frame buffers the window system and X Windows
appear on. The dzadmin tool appends a string to the end of the
/etc/dt/config/Xservers file when the dzadmin Install button is pushed.
Uncomment the appended line string at the end of the file by removing the pound
sign (#) in front of it, and comment out the old entry above it by adding a “#” in
front of the line.

See Chapter 5 of the Sun Fire V880z Server and Sun XVR-4000 Graphics Accelerator
Installation and User’s Guide for more details on how to modify the Xservers file.

8. If a window session is currently running, log out and log back in.

The window system restarts with the configuration changes you have made.

Or, if you are not already logged in, select Reset from the Options menu from the
desktop login screen, this causes the session to use the new settings.

dzstatus Status Tool
The dzstatus program, found in /usr/sbin, queries dzdaemon on the local host
and prints its status. dzdaemon is a daemon that runs in the background as part of
the Sun Fire Visual Grid system. It exchanges set up and connection initiation
information among computers in the system. dzstatus reports whether the local
dzdaemon is designated as a master or slave in the Sun Fire Visual Grid system, and
what network transport layer is being used for passing 3D graphics protocol.

This information can be useful in diagnosing configuration problems. See
Appendix A for troubleshooting information.

Note – The format of the dzstatus output is subject to change without notice.
Care should be taken in writing scripts that parse the output.
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Sun Fire Visual Grid Limitations
GLX (indirect) rendering on the master is supported (for example, master:0.2),
but the network connection used is TCP and not Myrinet. It is never correct to set the
display for indirect rendering to the slave display (for example, slave:0.0).

Only six concurrent OpenGL applications can simultaneously use the high-speed
Myrinet connection. The seventh and subsequent concurrent OpenGL applications
fall back to using the slower Gigabit Ethernet connection. Applications using the
slower link do not automatically migrate to the Myrinet connection if space becomes
available when one of the first six applications terminates. The application must be
restarted to use the faster network. This is only a performance limitation,
functionality is not affected.

Framelock and Genlock
For the Sun Fire Visual Grid system, framelock and genlock are configured as if all
the frame buffers were installed in the same host; therefore, the software setup and
cabling requirements do not change. All of the fbconfig commands are issued on
the master machine. The only difference is the device names, dzfbn is the device
name for the Sun Fire Visual Grid frame buffers (instead of zulun).

See the Sun Fire V880z Server and Sun XVR-4000 Graphics Accelerator Installation and
User’s Guide for details on how to framelock and/or genlock multiple Sun XVR-4000
graphics accelerators.
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CHAPTER 6

Security

This chapter describes the Sun Fire Visual Grid software security measures used by
the dzdaemon program.

� “dzdaemon Daemon” on page 51
� “Role-Based Access” on page 52

dzdaemon Daemon
The Sun Fire Visual Grid software uses a daemon (dzdaemon) running on each
computer in the installation to set up and control the Sun Fire Visual Grid system.
This dzdaemon is responsible for the following:

� Installing and modifying configuration files on the master computer
� Running dtlogin -kill on the slave computers
� Starting X window on the slave computers
� Starting oglserver on the slave computers
� Configuring and installing the dzfb devices on the master computer
� Configuring the Myrinet network

The dzdaemon daemon architecture has access to the system resources required by
the Sun Fire Visual Grid system. The architecture includes an optional trusted hosts
system to restrict which computers on a network can communicate with dzdaemon.

The Sun Fire Visual Grid software installation script prompts the user to create
trusted hosts files, although this option can be declined. On the slave computers the
trusted hosts file (/etc/openwin/dz/trustedhosts) is a text file that should
contain the names (or IP addresses) of the Gigabit Ethernet connection to the master
computer (or set of masters if the configuration is changed regularly) and
localhost. The name or IP address referring to the master in the slave
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trustedhosts file should be the same connection over which the master sends X
protocol to the slave. On the master, the trustedhosts file should simply contain
the name (uname -n output) or IP address of that master and localhost.

The Sun Fire Visual Grid system uses the following port numbers for master-slave
communication over TCP and UDP protocols:

These ports have been registered with the Internet Assigned Numbers Authority
(IANA) and can be referenced at:

http://www.iana.org/assignments/port-numbers

Role-Based Access
The Sun Fire Visual Grid system can provide role-based access to users of dzadmin.
This enables users other than root to modify the system setup using dzadmin.

To give a user the ability to run dzadmin:

� Add the following line (all on one line) to the /etc/user_attr file:

Where username is the name of the user to whom you are granting access.

TABLE 6-1 TCP and UDP Protocols

Program Protocol Port

dzdaemon 3866/tcp DZDAEMON Port

dzdaemon 3866/udp DZDAEMON Port

dzoglserver 3867/tcp DZOGLSERVER Port

dzoglserver 3867/udp DZOGLSERVER Port

username::::auths=solaris.dz.admin;profiles=Visual Grid Administration
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APPENDIX A

Troubleshooting

This appendix provides troubleshooting information.

� “Log Files” on page 53
� “General Troubleshooting Information” on page 54
� “Verifying the Myrinet Software” on page 55

For additional technical support, see Support Services at:
http://www.sun.com/service/online

Log Files
For information about installation problems, view the log files. The following log
files can be helpful in debugging installation problems:

/var/dt/Xerrors
/var/dt/dzlog
/tmp/dz_daemon_out
/var/dt/dz/master.*
/var/adm/messages

The file /tmp/dzdaemon_out on each computer might contain the output and
errors from the local dzdaemon.
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General Troubleshooting Information
� If dzstartup reports problems, review the log file /var/dt/dzlog. Try running

/usr/sbin/dzstartup start on the master.

� X startup errors are logged in /var/dt/Xerrors. If X fails to start, try starting
from the command line using Xsun -dev /dev/fbs/dzfb0. Since X takes
control of the local keyboard run this test from a shell that you log on to remotely
from the administration workstation. Test out each dzfb device independently in
this manner.

� If the slave needs to be rebooted, the system administrator might have to start
and - reset the Sun Fire Visual Grid system from the master as shown below
(preferably from a shell window on the administration workstation using rlogin
to communicate to the master computer).

� When installing a system from scratch, start without using Xinerama mode. When
the installation is complete, you can switch to Xinerama mode using the dzadmin
tool.

� Running /usr/sbin/dzstatus returns the current status of dzdaemon. This
should return DESIGNATED_MASTER on the master machine, and
DESIGNATED_SLAVE on the slave machine. If not, either reboot the machine with
the improper designation, or preferably, run dzstartup start from the master.

� A keyboard and mouse must always be plugged into the USB ports on the Sun
Fire V880z slave, otherwise the X server fails to come up properly.

� If you are using a trustedhosts file on the slave, make sure that the file
contains at least a “localhost” entry and the hostname of the master system
Gigabit Ethernet connection (not the master system 100 Mbit/sec connection). See
Chapter 6 for more details.

� A Sun Fire 4800 or Sun Fire 6800 often requires a -r flag to the boot command
(boot -r) in order to recognize the USB card, and to recognize the keyboard and
mouse. This flag, however, causes the X server to fail to start. You can discover if
this is the problem by:

� Looking for an error message in the /var/dt/Xerrors file that contains the
string VUIDGFORMAT.

� Confirming that there is no keyboard or mouse entry in the /dev/usb
directory, as there should be with properly functioning USB card software.

# /usr/sbin/dzstartup start
# /usr/dt/bin/dtconfig -reset
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Verifying the Myrinet Software
The Myrinet software is installed in three packages (SUNWmyril, SUNWmyrir, and
SUNWmryix) as part of the overall Sun Fire Visual Grid software installation. The
Myrinet cards should appear in the “Primary 3D Network” panel the first time that
the dzadmin tool is run. To manually verify the installation after the Sun Fire Visual
Grid software has been installed, type:

The output should list each of the boards installed in the local server.

# cd /opt/SUNWmyri/bin
# ./gm_board_info
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